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HOTSPOTS FOR TESTING: R-click Help
While printing: prtg status    Help button
Print Preview Help button
STANDALONE AND PRINTING MODES  
Main Tab
Printing Options tab
Cut marks
Second side instructions
Assembly instructions
What to Do Next
Modify Layout tab
Modify Layout tab
Layout
Save as
Save
Abandon Changes
# Across, # Down
@Mini-pages: Landscape/Portrait@
Width, Height
Page Ordering (folded/cut/sequential)
Standard/Flip book
Single-sided/double
Scaling
Binding space
Top margin
Left margin
Sheet size
Sheet orientation
@Special paper@
Inches/cm
@Show layout@

List Management tab
List Management tab
Layout list (mention reordering)
Delete
Rename
Hide
Unhide

Help tab
Help tab
Help Contents
Help Index
Assoc'd Topics
What to Do Next 

STANDALONE ONLY
Main tab
Main tab (welcome)
Exit

Printing Options tab
Printing Options tab



Modify Layout tab

List Management tab

Printer Setup tab
Printer Setup tab
Printer to Set Up
Printer Setup button

Help tab

PRINTING ONLY
Main tab
Main tab (printing stuff)
Print button
Cancel (on Main tab)
Cancel (on popup menu)
Print (on popup menu)
Return (on popup menu)
Layout picture (incl Bk View, Layout View)
Layout (list)
Printing to
Printing Status
Print Preview

While printing
Printing Options tab
Printing Options tab
Number of Copies

Modify Layout tab

List Management tab

Help tab



Exit
Quits ClickBook.



Layout
The selected layout, shown in the picture, determines how your document will print.    As you select 
different layouts, the picture changes.    

A layout is a specification of many settings, which you can see by going to the Modify Layout tab.    An 
important setting is the Clickbook Style, which is indicated in some layout names:

"Tiled" designates a tiled layout: designed for no cutting.
"Cut" designates a cut-book layout: designed to be cut and bound as a book.
"Folded" designates a folded-book layout: designed to be folded and stapled.
"Tri-Fold" and "Tri-Flip" are brochure layouts: a single sheet, meant to be folded twice, forming 

three panels.

For much more information about layouts, go to the Help tab.



Layout picture
Shows the currently selected layout.    Clicking repeatedly on the picture cycles through all the layouts.

The picture shows how many pages are printed on one paper sheet and how they are arranged and 
numbered.    (The pagination shown is for a document that fills only one sheet.    Your printout may be 
different.)

Dashed lines show where to cut, and dotted lines where to fold.



What to do next
Offers suggestions for how to proceed.    For complete information about using ClickBook, go to the Help 
tab. 



Main tab
Introduction to ClickBook, plus option to Exit ClickBook.



Modify Layout tab
Offers options to create and modify layouts.



List Management tab
Offers options for managing the list of layout names on other tabs.



Layout list
Shows all the layouts in your system, whether hidden or not.    Hidden layouts are shown here as dimmed.

Select a layout in the list, and then choose whether to rename, hide/show, or delete it.    



Delete
Permanently deletes a layout from your system.    Choose Hidden instead if you don't want the layout 
now but might want to use it again someday.



Rename as:
Enables you to enter a new name for the layout.    Note that layout names can be much longer than    
filenames.



Hidden
Makes a layout 'invisible' in the layout list on other tabs.    You can make it visible again by choosing 
Shown.



Shown
Makes a hidden layout visible again in the layout list on other tabs.



Printing Options tab
Offers options to change global settings, that is, options that apply to ClickBook generally rather than to a 
specific layout.



Printing Options tab
Offers options to change global settings (those that apply to ClickBook generally rather than to a specific 
layout), plus Number of copies to print of this print job.



Help tab
Offers complete information about using ClickBook.    You can choose a category of Help or a specific 
topic, or browse through the text.



Standalone:

Printing Options tab



Print cut marks
If on, each printout that requires cutting will include marks to indicate the location and order of the cuts.



Print second side instructions
If on, double-sided printouts will include an instruction sheet that tells you how to reinsert the printout 
stack before printing the second sides.



Print assembly instructions
If on, each printout that requires cutting will include an instruction sheet that shows how to cut and 
assemble the book.



Standalone:

Modify Layout tab



Layout
Shows the layout to be modified.    Select the layout you want to change before changing any settings.

To create a new layout, select a layout close to what you want, and then modify settings and save it with a
new name.    You can modify any or all of the settings, so the choice of which layout to start from makes 
no difference except convenience.



Save
Saves the layout as changed, using the name in Save as.



Abandon Changes
Restores the selected layout to the settings it was last saved with. 



Save as:
The name the changed layout will be saved with.    If you keep the original name, the original layout will be
overwritten when you click Save.    If you change the name, saving will create a new layout and preserve 
the original.



Mini-Pages on Sheet
How many mini-pages to print on one sheet of paper, given as the number of mini-pages Across and the 
number of mini-pages Down.    

If you specify these, ClickBook will calculate the size of each mini-page.    You can then decrease the size,
if you wish, by turning on Use Absolute Dimensions and then setting Width and Height.



Use Absolute Dimensions
Turn on this option if you wish to specify the actual Width and Height of a custom mini-page (final 
clickbook page) size.    When it is off, ClickBook sets Width and Height to the maximum size that will    fit 
on the paper.



Width, Height
The dimensions of each mini-page.    ClickBook calculates these automatically to the maximum size that 
will fit on the sheet of paper.    You can decrease these after turning on Use Absolute Dimensions, for 
example to match a custom page size exactly.



Sheet Orientation
Orientation of the sheet of paper.    This is independent of the mini-page orientation.    To see what 
Portrait and Landscape mean, click on each in turn and watch the layout picture.



Clickbook Style
The four basic types of clickbooks (ClickBook printouts).    Choose Folded Book if you will fold between 
facing pages (for thin, usually stapled books).    Choose Cut Book if you will cut between facing pages 
before binding (for example, to punch holes and use a ring or spiral binding). 

Choose Tiled if you wish to print several mini-pages to a sheet but not to cut the sheets.    Choose Tri-
fold for a single-sheet brochure, to be folded twice, making three panels.



Binding Orientation
Choose Standard if you will bind the book on the left (and turn the pages in normal book fashion), and 
Flip if you will bind it on top (and flip the pages up).



Print Sides
Choose whether to print one or both sides of the paper.    In Double-sided printing, ClickBook will print 
one side, then instruct you how to reinsert the paper, and then print all the second sides.

Note: Single-sided printing is not available for all types of layouts.    If unavailable for the currently 
selected layout, it's displayed as dimmed.



Scaling
Choose Auto-scale to let ClickBook decide how to shrink your document's pages to fit on the mini-pages.
Choose Preserve shape to shrink proportionally, in order not to distort the shape of graphics or fonts.    

Choose No scaling if you have prepared your document at exactly the size you want it to print.    In this 
case, you must make certain that the mini-page size accommodates the page size as defined in your 
application program.



Binding margin
This is extra white space, in addition to standard margins, at the page edges where you will bind the 
book.    (Also known as a "gutter".)    The space will be added on the appropriate side of each page, 
according to whether it's a Folded or Cut book, and whether Normal or Flip.



Left/right margin
The size of ClickBook margins on the left and right sides of the mini-pages.    These are in addition to the 
margins you set in your application program -- but remember that those margins will shrink as ClickBook 
shrinks the pages to fit several to a sheet of paper.



Top/bottom margin
The size of ClickBook margins on the top and bottom of the mini-pages.    These are in addition to the 
margins you set in your application program -- but remember that those margins will shrink as ClickBook 
shrinks the pages to fit several to a sheet of paper.



Paper Size
The size of the paper you'll use with this layout.    The Width and Height of the currently selected paper 
size are shown for your information, but you cannot reset them. 



Units
The unit of measure for numeric settings on this tab, namely, mini-page dimensions and margins.



Layout picture
Shows the currently selected layout.    Clicking repeatedly on the picture cycles through all the layouts.

The picture shows how many pages are printed on one paper sheet and how they are arranged and 
numbered.    (The pagination shown is for a document that fills only one sheet.    Your printout may be 
different.)

Dashed lines show where to cut, and dotted lines where to fold.



Standalone:

Printer Setup tab



Printer Setup tab
Run Printer Setup to set up an additional printer for use with ClickBook, or to set up a ClickBook printer 
again if it is not printing properly.



Printer to Set Up
Select the printer you wish to Run Printer Setup on.    Printer Setup will create (or modify) the ClickBook 
version of that printer driver.



Run Printer Setup
Analyzes your printer through a print exercise.    This gives ClickBook information about your printer that is
necessary for double-sided printing.    Run Printer Setup if there's no ClickBook driver for that printer, or if
printouts are coming out "double-exposed" or upside-down.



Standalone:

Help tab



Help Contents
Lets you choose a category of Help information.    This will cause either another menu or a Help topic to 
display.

If you have a specific topic in mind, use the Help Index instead.    It allows you to find Help by keywords 
or phrases and topic titles.



Help Index
Offers key words and phrases you can look up to find the Help topic you need.    Browse through them 
and single-click on a keyword to see its Associated Topics.    Double-clicking on the keyword goes to the
first associated topic listed.

You can go to any topic listed in the Associated Topics box by double-clicking on it.



Associated Topics
Lists topics relating to the currently selected keyword.    Double-click any Associated Topic to go to it.



What to do next
Offers suggestions for how to proceed.



Print mode:

Main tab



Main tab
Offers options to select a layout and print the current print job using the selected layout, and other related 
options.



Printing to:
Shows the printer selected in your application program.    If it's not the one you wish to print to, you must 
cancel the print job and then, in your application, select the desired printer and give the print command 
again.



Printing Status
Advises you of the progress of the printing job.    

Before you begin printing, it indicates how many pages of your document have been received from the 
application program.    Click the Print button whenever you are ready.    You don't need to wait for all the 
pages to be received.



Print
Begins formatting your print job according to the selected layout and sending it to the printer.

Click the Print button when all ClickBook settings are as you want them and you are ready to begin 
printing the current document.    Especially be sure that you have selected the layout you wish to use.



Print Preview
Shows generally how your document will look when printed in the layout currently selected.



Help
Provides information about using Print Preview.



Front/Back
Indicates which side of the printout is currently shown.    Changing between Front and Back flips the 
sheet over and shows the other side.    



Next
Displays the same side of the next sheet.    

If you're looking at the front side, click Back to see the back of the current sheet. 



Previous
Displays the same side of the previous sheet.      

If you're looking at the back, click Front to see the front of the current sheet.



Last
Jumps to the last sheet of the printout.    Note: If the Front side is currently displayed and you want to see 
the back of the last sheet, you must click Last, and then Back .



First
Jumps to the first sheet of the printout.    Note: If the Back side is currently displayed and you want to see 
the front of the first sheet, you must click First and then Front.



Return
Exits the Print Preview and returns to the Main tab of ClickBook.



Print
Click Print if you're ready to begin printing.



Cancel
Offers alternatives in case you don't want to print right now, or don't want to use a ClickBook layout.



Cancel
Cancels the print job and returns to your application program.



Print
Prints as though you had printed directly from your application -- not in a ClickBook layout.



Return
Exits the Cancel menu, returning to ClickBook's Main tab.



Print mode: Printing Options



Number of copies
If you wish to print multiple identical printouts, set the desired number. 

Wait till the first sides of all copies have printed before removing and reinserting the printout stack.    There
will be just one instruction sheet.    Handle the stack as a single printout.    

When all second sides are done, separate the copies and then cut and assemble each individually.



Print mode:

Layout options



Print mode:

Printing options



Print mode:

Help tab



[Blank Page]



What to do next

1. In the list below the layout picture, select the layout to modify.    To create a new layout, select an 
existing one that's similar to what you want.

2. If you don't want to overwrite the original layout, enter a new name in the Save as: box. 

3. Make the changes you want.    Right-click on any option for information about it.    

To see the effect of changing any setting, watch the layout picture as you change the setting.

4. When you're done, click either Save or Abandon Changes.



What to do next

There are two ways to find information in Help:

To choose a major Help category, click on it in the Help Contents box.

To choose a specific Help topic, click on a pertinent word or phrase in the Help Index.    Then 
double-click on the desired topic in the Associated Topics box.

After you choose a Help topic, the Help window will appear.    To return to ClickBook from there,    choose 
the Exit option from the File menu.



What to do next

Explore ClickBook.    Help is available in several places:

Right-click on any box or button, etc., for information about it, and
Read the one-line description at the bottom of the ClickBook window.
Go to the Help tab for the complete Help system.

Use ClickBook: 

To print, choose a layout for your printout, and then click Print.    
If you didn't want ClickBook for this print job, click Cancel. 
To create or modify layouts, go to the Modify Layout tab.
To change global settings or print multiple copies, go to the Printing Options tab.



Previewing a printout

Print Preview is not accurate in every detail, and your printout will look better than the preview.    Use 
your application program's print preview to view each (mini-)page in detail.    Use ClickBook's to see 
generally how the printed sheets will look, including: how the mini-pages are positioned, the relative sizes 
of margins and data, how many sheets will print, and how many blank mini-pages will be printed at the 
end.

Choose Front or Back to flip the sheet over and see the other side.    

Click Next or Previous to see the next or previous sheet.    Note that Print Preview shows printed 
sheets.    So if you want to look at the mini-pages in order, you may have to alternately click Next and 
switch between front and back sides.

Click Last or First as shortcuts to go to the last or first sheet.

Click Return to exit Print Preview and return to the Main tab of ClickBook.

Click Print if you're ready to begin printing.



Important tips for preparing to print the second side
Be sure that all pages of the first side have printed before removing the printout stack.

Remove the printout stack from the printer without rearranging the pages.    Make certain, if any 
other print jobs were sent to this printer, that you are holding only your intended printout.      If you're on a 
network and the printer prints an extraneous separator sheet between printouts, throw out that sheet.

Turn the stack over if necessary to find the instruction sheet.    Read the instruction sheet without 
lifting it off the stack.

If you're sharing a network printer:    Before reloading your printout stack into the printer, you must
assure that your second-side job will print next.    Do this through your network software, by talking with all
other users, or by being the sole user on the network.

Reinsert the stack with the instruction sheet still on it.
If your printer puts out an extraneous sheet before each print job (e.g. printout separator sheets 

on network printer),    place a blank sheet on top after reinserting the stack.
If the printer went off-line when you reinserted the stack, turn it back on-line.



Print Second Side
After the last page of the first side has printed, and you've reloaded the printout stack into the printer 
according to the instructions, and the printer is ready to print... then click Print Second Side to begin 
printing the back side.



Help
Gives important tips to ensure that the back side of your printout is printed correctly.



Cancel
Cancels the print job!



BookMaker Corp. License Agreement

BookMaker Corporation grants you a license to use the enclosed ClickBook(tm) software in 
accordance with the terms of this agreement. 

ClickBook is a software product protected under copyright laws in the United States and by 
international copyright treaty provisions. You may treat this software product as you would a 
book, with the exception that you may install it on a computer. You are also granted the right to 
make archival (back-up) copies of the software to protect your investment against loss and 
damage.    

By asking you to treat this software program as you would a book, we mean that it may be used 
by any number of people and moved freely between computers so long as only one person uses 
this software at one time. Just as one book cannot be read or used by two different people at 
different places at the same time, you may not have more than one person using this copy of the 
software at the same time. If two or more people can use this one copy of software at the same 
time you should purchase additional copies to avoid violating our copyright (to purchase 
additional copies call 800 766-8531).

You may transfer the software and accompanying documentation to another person if you do not 
retain any copies of the software and the other person agrees to this license. 

BookMaker Corporation
625 Emerson Street Suite 200
Palo Alto, CA 94301
(415) 617-1100
Fax (415) 323-0108




